Getting Started
Table of Contents
Installation 7

Welcome! 8
About the manuals 8
What is in the Reason package? 9
Requirements 9
About the Audio Hardware 10
About MIDI Interfaces 12
Installing the Software 13

Setting Up 15

About this Chapter 16
First run - Reason Setup Wizard 16
About the Preferences 18
Setting up the Audio Hardware 19
Setting up MIDI 21
Setting up the Default Song 25

Guided Tour 27

About this Chapter 28
Guided Tour 28
Tutorial 1 - Playing a Song 43
About this tutorial 44
Playing a Song 44

Tutorial 2 - Playing devices and selecting sounds 47
About this tutorial 48
Adding a mixer and an instrument device 48
Selecting a patch 51
Adding an effect 52

Tutorial 3 - Creating a drum pattern 55
Creating a drum pattern 56

Tutorial 4 - Recording a bass line 59
About this tutorial 60
Browsing for a bass sound 60
Recording notes in the sequencer 62

Tutorial 5 - Adding a REX loop 67
About this tutorial 68
Adding a REX loop 68
Tutorial 6 - Adding an arpeggio 71

About this tutorial 72

Adding an arpeggio 72

Automating a parameter 74

Index 75
Chapter 1
Installation
Welcome!

Thank you for purchasing Reason!

Ten years have passed since we released Reason to the world and you are holding the fifth major version of Reason in your hands - a version adding the mighty Kong Drum Designer and the updated REX player Dr. Octo Rex to your rack, live sampling on all sampler devices, a completely new way of sequencing your tracks, and many, many more improvements. We've added all this while maintaining the look, flow and features of the Reason you know and love. We are proud to say that this is the best version of Reason so far. And we'll hope you'll like it just as much as we do!

A strong driving force for us at Propellerhead is communication with all the people around the world that use our programs to realize their musical ideas. And a big part of this communication takes place on our own user forums. This is a unique meeting place where professionals and beginners meet on equal terms to exchange ideas. But even more importantly, it's a forum open to you! We think you will enjoy talking to other Reason users all over the world, just as much as we'll enjoy talking to you.

See you on the Propellerhead web!
Yours truly,
The Propellerhead Software Team
www.propellerheads.se

About the manuals

This is the Getting Started Manual, a guided tour of the basic features and procedures in Reason. The manual also includes six short tutorials to help you get going with the program.

Detailed features and operations in Reason are described in the Operation Manual, a file in Adobe Acrobat (".pdf") format. This and other pdf documents are installed with the program - you find them in the Documentation folder inside your Reason application folder. The Operation Manual also contains reference descriptions of all Reason devices and commands.

To read the Operation Manual on Windows systems, you will need the Adobe Acrobat Reader application. Since this has become something of a household utility application, chances are you already have it installed on your computer. If not, run the Acrobat Reader installer included on the Reason installation DVD. To read pdf files under Mac OS X, you can use Preview instead.

About Mac and Windows

Reason runs under Mac OS X and Windows (for operating system details, see below). All Reason packages contain program versions for both platforms. Everything said in the manuals applies to both platforms, unless explicitly stated.

If you are running Mac OS X, please note that there's an additional menu called the Reason menu, which is not present under Windows. This contains the Preferences menu item (otherwise found on the Edit menu).
What is in the Reason package?

When you purchase Reason, the package contains the following items:

**The Reason 5 installation DVD**

This disc contains the main Reason program installer and the Reason Factory Sound Banks, two large files containing samples, patches and loops for use with Reason. These are copied to your hard disk the first time you launch Reason (see "About the Sound Banks" on page 13 for more information). In addition, the DVD contains documentation in Adobe Acrobat format, and an installer for Adobe Acrobat Reader.

**The product authorization card**

This contains the license number required for the installation. Keep this card in a safe place, in case you need to re-install Reason!

! Note that if you bought Reason from the PropShop, it is already registered to your account.

**The Getting Started Manual**

The manual you are reading right now!

Requirements

Below you will find the minimum requirements for running Reason Version 5:

! Note that these are the minimum requirements! You will benefit from a fast computer with a lot of RAM, since this will allow you to use more devices at the same time.

**Mac OS X**

- Intel Mac (multiple cores highly recommended)
- 1 GB RAM or more
- DVD drive
- Mac OS X 10.4 or later
- 2 GB free hard disk space
- Monitor with 1024x768 resolution or better
- CoreAudio compliant audio interface or built-in audio hardware
- A MIDI interface and a MIDI keyboard recommended

**Windows**

- Intel Pentium 4/AMD Athlon or better (multiple cores highly recommended)
- 1GB RAM or more
- DVD drive
- Windows XP SP3, Vista or Windows 7
- 2 GB free hard disk space
- Monitor with 1024x768 resolution or better
- A 16 bit Windows compatible audio card, preferably with an ASIO driver
- A MIDI interface and a MIDI keyboard recommended.
About the Audio Hardware

The audio hardware is the computer equipment that converts the digital signals from Reason to analog audio signals (for connection to an amplifier, headphones, or similar). It also converts analog input signals from microphones or instruments to digital signals that Reason can sample or process in other ways. This equipment could be a standard stereo sound card, a USB audio interface, the built-in audio hardware on a Macintosh or some more advanced audio card with several inputs and outputs, digital connectors, etc. Regardless of which, you need to make sure the hardware and its drivers are properly installed:

Audio hardware and Mac OS X

If you are going to use only the outputs of the built-in audio hardware

In this case you don't need to make any extra settings. Just connect the audio output to your listening equipment (speakers, mixer, headphones or similar) and make sure your Mac plays audio properly.

If you are going to use both the inputs and outputs of the built-in audio hardware

All Mac models come with a built-in audio interface, providing stereo input and output jacks (and in some cases a built-in microphone). Depending on your needs, the quality of these inputs and outputs may be fully sufficient for use with Reason.

If you use Mac OS X 10.5 and later, Reason provides a number of pre-configured Input(s)+Output(s) combinations that can be accessed from the Audio tab in Preferences. However, under Mac OS X 10.4 the system presents the built-in inputs and outputs as two or three individual audio devices. This means that, by default, you can only select the "Built-in Output" option in Reason's Preferences. This works fine for playback, but since you get no inputs at all, you cannot record audio.

To get access to both built-in inputs and outputs, you need to create an "Aggregate Device", combining inputs and outputs into one "virtual" audio device. This is done in the Aggregate Device Editor.

Although Aggregate Devices can be used, regular audio devices with both inputs and outputs have proven to be more reliable and allow lower latencies. Therefore, we recommend using external audio hardware with good Core Audio drivers instead.

Proceed as follows to create an Aggregate Device:

1. In OS X, open “Audio MIDI Setup” in the “Utilities” folder in “Applications”.
2. Select “Open Aggregate Device Editor” from the Audio menu.
3. In the Aggregate Device Editor, click the “+” button to create a new aggregate device. If you like, you can rename your new aggregate device.

4. Place a tick in the “Use” check boxes for each of the Audio Devices you want to use. For example, if you want to use the “Built-in Line Input” and “Built-in Output”, tick these two boxes.

   ! If you want to use the “Built-in Microphone” together with the “Built-in Output”, note that there might be audio feedback loops if you use the computer’s internal speakers or external speaker close to the built-in microphone! We recommend NOT using the “Built-in Microphone” option, partly because of the feedback loop problem and partly because of the limited audio quality of the built-in microphone.

5. Click “Done” to finish and exit the Aggregate Device Editor.

6. In the Audio MIDI Setup window, choose the Aggregate Device you just created by selecting it in the “Default Input” and “Default Output” drop-down lists respectively.

7. Select your Aggregate Device from the “Properties For” drop-down list and set up the “Format” in the drop-down lists that appear in the “Audio Input” and “Audio Output” sections at the bottom of the window.

   ➔ Choose “2ch-24bit” for best audio resolution.

8. When you're done, exit the Audio MIDI Setup.

   ! If Reason was running while you created you new aggregate device, you'll have to restart Reason for the new aggregate to be available in the “Audio Card” drop-down list on the “Audio” page in the Preferences dialog.

If you are using other audio hardware with your Macintosh

You may want to use other audio hardware with Reason (e.g. an audio interface with multiple outputs, digital connections, etc.). For this to be possible, the audio hardware must be compatible with Mac OS X, i.e. there must be a Mac OS X driver available for the card.

1. Install the audio hardware and its drivers as described in its documentation.

2. Connect the stereo outputs of your audio hardware to your listening equipment (speakers, mixer, headphones or similar).

   For info about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual pdf. For now, we stick to standard stereo connections.

3. If possible, test that audio plays back OK with the audio hardware.

   With some audio hardware, a test application is supplied for this purpose.

Audio hardware and Windows

! To run Reason with full audio in and audio out functionality under Windows, an ASIO driver is required for the audio hardware.

Reason can be run with DirectX or MME drivers as well but this will only support audio out - and at considerably higher latencies than with ASIO drivers.

• If there is no ASIO driver available, you should make sure your audio card supports DirectX.

   DirectX is a Microsoft protocol for handling audio and other multimedia aspects.

• As a last resort, you could use audio cards that don't support ASIO or DirectX, provided that they are Windows compatible.

   In this case, Reason will communicate with the audio hardware via MME (Windows Multi Media Extensions). However, most often this results in large latency values (see “About Latency and other Audio Settings” on page 20), making real-time playback of instrument devices difficult or even impossible.
Regardless of which type of audio hardware or drivers you are using, you should follow these basic steps:

1. **Make sure you have the latest drivers for the audio hardware!**
   Please check the manufacturer's web site for the latest versions.

2. **Install the audio hardware and its drivers as described in its documentation.**

3. **Connect the stereo outputs of your audio hardware to your listening equipment (speakers, mixer, headphones or similar).**
   For information about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual pdf. For now, we stick to standard stereo connections.

4. **If possible, test that audio plays back properly with the audio hardware.**
   In the case of audio hardware with ASIO drivers, you will need some test application for this (often included with the audio hardware). If you are using DirectX or MME drivers, you can use Windows' Media Player application for this.

### About MIDI Interfaces

While it is possible to use Reason without an external MIDI controller (by playing patterns and loops only, or drawing notes and automation in the sequencer), this would not allow you to use the program to its full potential. From now on we assume that you are using a MIDI interface and some kind of external MIDI controller (typically a MIDI keyboard with a built-in USB interface).

- **When installing the MIDI interface and its drivers, follow the instructions in its documentation carefully.**
  - **While a MIDI interface with a single input is sufficient, you will benefit from having two or more individual inputs.**
    This is especially true if you want to manipulate Reason parameters with additional MIDI control surface devices or use the program in conjunction with an external, stand-alone sequencer, groove machine or similar.
  - **For some MIDI interfaces connected via USB, no driver installation is required. Just plug in the interface and you're ready to go!**
  - **For other, more advanced MIDI interfaces (or at least to take advantage of more advanced features, like multiple inputs) you will need to install a driver.**
    Please consult the documentation that came with the interface for details.

### MIDI Connections

- **Simply connect the USB cable from your keyboard to your computer.**
  Although many USB MIDI keyboards are "plug-and-play", some may require a driver to be installed. Consult the documentation that came with your MIDI keyboard or visit the manufacturer's web site. Drivers are usually downloadable.

  Or

- **Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI controller) to a MIDI In on your MIDI interface.**
  This is sufficient to be able to play and record notes and controllers in Reason from the MIDI keyboard.

- **If you are not using a USB keyboard, you may also connect the MIDI Out from the MIDI interface to the MIDI In on your MIDI keyboard.**
  This is not strictly necessary to use Reason, but it will enable two-way communication when you run the Reason Setup Wizard which appears the first time Reason is launched (see "First run - Reason Setup Wizard" on page 16), or when using Auto-detect Surfaces in the Preferences. Whether auto-detection works or not depends on the keyboard model.
If you have several MIDI control surfaces or similar that you want to use, we recommend that you connect them to separate MIDI ports (or directly to the computer using USB).

Installing the Software

Upgrading vs. New Installations

If you are upgrading from a previous version of Reason, please note the following:

- **Our recommendation is that you uninstall the previous version before installing the new one.**
  - Under Windows, please use the Uninstall feature.
  - Under Mac OS X, just drag the program files to the Trash.
  - Uninstalling will ensure that there is no confusion between versions and that shortcuts and aliases point to the right files etc.

Running the Installer

Now it’s time to install the actual Reason software:

- **Insert the Reason Version 5 disc into your DVD drive.**
  - What to do next depends on whether you are installing on a Mac or a Windows computer.

Windows:

1. **On the DVD, locate the file called “Install Reason” and double click on it.**
   - Under Windows, the installer may automatically start when you insert the DVD, depending on your system settings.

2. **Follow the instructions on screen.**
   - Before executing the installation of the software components, you will be asked to select a language, an install location, and whether you wish to create a program shortcut/alias on your desktop. When the installation is complete, you have the option of launching Reason directly.

Mac OS X:

- **On the Mac, there is only a folder called “Reason” - simply drag this to your hard disk.**

About the Sound Banks

The first time you launch Reason, you will be asked to insert the Reason Version 5 disc to copy the Factory Sound Bank and the Orkester Sound Bank. These each consist of one big file, containing a large number of patches, samples and loops, serving as your main supply of sounds (much like the sound ROM in a synthesizer).

These are copied to your hard disk and are required to run the program.
Launching the program

Now, the Reason files have been installed in a folder on your hard disk. Under Windows, all Reason related items have also been added to the Start menu and possibly you will have a Reason shortcut on the Desktop.

1. **Check for any ReadMe files in the Reason folder or on the Start menu, and open and read these.**
   ReadMe files may contain important last minute information that didn't make it into this manual.

2. **Launch the program by double clicking the Reason icon (or by selecting the Reason item from the Start menu).**

3. **First a Licensing Agreement is shown.**
   Read it through and click "Agree" to proceed.

4. **You will now be asked to insert the Reason Version 5 disc (if this is not already loaded).**
   The Factory and Orkester Sound Banks will be automatically copied into the Reason Program folder. During this process, which will take a while, various splash screens are shown, along with a progress meter.

5. **Fill in the authorization form that appears.**
   Your license number can be found on the product authorization card included in the package.

   At this point a dialog appears, asking you whether you want to register your copy of the program at the Propellerhead web site. Registering gives you immediate access to various benefits such as free, extra sounds for Reason!

   ! **You must have a working Internet connection to be able to register on-line.**

   ➤ **If you click the Register Now button, your Internet browser will launch and take you to the registration page on the Propellerhead web site.**
   Follow the instructions on the web page. After finishing the registration, click the Continue button in the installation dialog.

   ➤ **If you don’t want to register at this point, click the Later button.**
   You can register at any time by selecting Product Registration from the Contact menu (Mac) or Help menu (Windows) in Reason (or by going to www.propellerhead.se/register).

This completes the installation and the program is opened, but a new dialog appears named “Reason Setup Wizard” which will guide you through the basic settings needed to use Reason.

This is described in “Setting Up” on page 15 so just leave things as they are for now and go to the next chapter...
Chapter 2
Setting Up
About this Chapter

This chapter describes the settings you need to make before you can start using Reason. These are necessary in order to get any sounds to and from the program and to be able to play and control Reason via MIDI.

First run - Reason Setup Wizard

If you followed the instructions correctly in the last chapter, Reason should be running, and the first dialog in the "Reason Setup Wizard" guide should be open.

This only appears the very first time the program is run.

- Note that the Language page only appears in the Windows version of Reason. In Mac OS X, the selected system language is automatically used.
- Note that any settings made in the Setup Wizard can always be changed later in the Preferences!

- Clicking Next will take you through a series of dialogs, where the following happens:
  - The Setup Wizard will first try to find a compatible audio driver.
    It will automatically select the first compatible driver it finds. If this is the driver you wish to use, fine. If it isn't, select your preferred driver from the Audio Card Driver pop-up. If you don't know which driver to use, see "Setting up the Audio Hardware" on page 19.
  - To get both inputs and outputs in the same driver under Mac OS X 10.4, it is required that you create an Aggregate Device. For information on how to do this, please see “If you are using the built-in audio hardware in your Macintosh” on page 13.
  - Next, Reason will try to auto-detect a master keyboard.
    If one is found and you want to use this, click "Use" and proceed.
  - For Reason to auto-detect a device you need two-way MIDI communication! Non-USB keyboard devices without a MIDI input can of course still be added manually.
  - Note that your keyboard model might not be auto-detected by Reason, even though it's a modern one and connects via USB. However, you can still use such a keyboard to control Reason and use Remote in the same way as with an auto-detected keyboard.
If Reason can't find the keyboard you have connected, or if you clicked “Don't Use”, you will be asked to specify a master keyboard manually. This is done by first selecting a Manufacturer, and then a model. If your model keyboard isn't on this list select “Other” - see below.

You will also have to specify a MIDI port to use. This can be done either by selecting one of the available ports listed in the popup, or by clicking the "Find…" button and pressing some keys on your keyboard.

Note that if you have additional remote control surface devices in your setup, these will have to be added in the Preferences - see “About the Preferences” on page 18. The Setup Wizard will only establish a connected Master Keyboard device.

If all went well, you should now have established audio and MIDI communication - the basics needed to play back audio and to direct MIDI to Reason! Reason will launch and bring up the default song.

However, if for any reason the Setup Wizard failed to establish the necessary settings, or if you wish to add other devices etc., you have to make settings in the Preferences.

Read on…
About the Preferences

The basic settings for audio and MIDI are done in the Preferences dialog. This is opened from the Edit menu (or, if you are running Mac OS X, from the Reason menu).

- Described herein are only the most important settings in the Preferences. For information about other Preferences settings, see the “Menu and Dialog Reference” chapter in the Operation Manual pdf.
Setting up the Audio Hardware

In case this wasn’t done in the Setup Wizard, you need to establish a connection between Reason and the audio hardware. This is done by selecting a driver - a software component that acts like a link between the program and the audio hardware. Proceed as follows:

1. **In the Preferences dialog, use the pop-up menu at the top to select the Audio page.**

![Preferences dialog](image)

2. **Pull down the Audio Card Driver pop-up menu and select one of the options.**

Which option to select depends on the platform and the audio hardware. If an option is not applicable to your setup it will be greyed out in the dialog.

**Mac OS X**

! **Under Mac OS X it’s required that the audio hardware supports Core Audio drivers.**

- Select the option that corresponds to the hardware you want to use (the built-in audio connectors or some additional audio hardware that you have installed).

- If you are using Mac OS X 10.5 or later, a number of predefined combinations of built-in inputs and outputs are also available in the Audio Card Driver pop-up. The number of available input(s)+output(s) combinations depends on your computer’s specific configuration.
Windows

To be able to use both audio inputs and outputs, it's required that the audio hardware supports ASIO drivers.

- If you are using audio hardware for which there is a specific ASIO driver, you should select this.
  With an ASIO driver written specifically for the audio hardware, Reason can communicate more or less directly with the audio hardware. The benefits are lower latency (see below) and possibly better support for additional hardware features such as multiple outputs.

- If there is no specific ASIO driver, you should select the Direct Sound driver for the audio hardware.
  This makes Reason communicate with the hardware via Direct Sound (a part of the Microsoft DirectX package). You need to have DirectX installed on your computer, and there must be a Direct Sound driver for the audio hardware. You will only be able to use audio outputs in this scenario.

- If the audio hardware doesn't support Direct Sound (i.e. there is no Direct Sound driver available for the audio hardware), select the MME driver.
  This makes use of Windows Multimedia Extensions, the part of Windows that handles audio, MIDI, etc. Using MME often results in larger latency values (see below). You will only be able to use audio outputs in this scenario.

About Latency and other Audio Settings

In the audio page, you will find a number of additional settings for audio. The most important ones are Buffer Size and the corresponding readout for Input and Output Latency.

The Input Latency is the delay between when the audio is "sent" from a connected microphone or instrument and when it's received and detected by Reason. Output Latency is the delay between when audio is "sent" from Reason and when you actually hear it. The latencies in an audio system depends on the audio hardware, its drivers and their settings.

If the output latency is large, you will notice that the sound is delayed when you play a device from a MIDI keyboard. You may also notice that reactions are delayed when adjusting controls on the device panels (for example, if you lower the volume of a device, you will not hear this immediately but after the latency time).

If you experience high latency values, you will need to make adjustments to your configuration.

- If available, use the Buffer Size slider to lower the latency.
- If the Buffer Size slider is greyed out, you may be able to lower the buffer size in the control panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the Operation Manual.
Setting up MIDI

In Reason, MIDI keyboards or remote control devices are called control surfaces. MIDI input from control surfaces is handled by a system called Remote. Here are some of the main features:

- **You can use any number of control surfaces at the same time.**
- **The program supports a large number of control surfaces out of the box - knobs, faders and buttons on the surfaces are automatically mapped to the most useful parameters on the Reason devices.**
  You don't have to change the settings on the control surface to control different devices in Reason - if you change MIDI focus from a Subtractor track to a Malström track, the control surface will automatically adapt. You just set up your control surface once and for all for use with Reason - the program handles the rest!
- **For control surfaces that are not natively supported at this stage, you can use generic drivers.**
  With the generic drivers, you can use templates or settings compatible with Reason 5, if available for the control surface.
  Note however, that Remote drivers for additional control surfaces will be added continuously - check our web page for more info.
- **By default, all control surfaces follow the sequencer Master Keyboard Input.**
  This means that you set MIDI input to a track in the sequencer to route the control surface(s) to the track's device in the rack.
- **You can lock a control surface to a specific device in the rack.**
  For example, you could have a master keyboard that follows MIDI input, while another control surface is locked to the main mixer in the rack. This way you can control levels and pans at all times. This is described in the Operation Manual.
- **You can use remote overrides to map a specific control on a surface to a specific Reason parameter or function.**
  For example, you could override-map a knob or fader on your control surface to the mixer's master level fader. Or you could map buttons on your control surface to control Reason's transport (play, stop, record, etc.) at all times, regardless of which track has Master Keyboard Input in the sequencer. This is described in the Operation Manual.
- **Remote also supports some control surfaces with MIDI feedback.**
  If you have such a control surface and it is supported by Reason Version 5, you can take full advantage of motorized faders, meters, displays, etc.

Among the Reason documentation you will find a document called “Control Surface Details”. This contains useful information about the supported control surfaces.

In case you specified a master keyboard in the Setup Wizard, and you don’t have any other control surfaces, you don’t have to do anything else. But if you want to add additional control surfaces or edit your settings, this is done in the Preferences.
Adding a control surface

1. Open the Preferences dialog and select the Keyboards and Control Surfaces page.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connection), try clicking the Auto-detect Surfaces button.
   Reason scans all MIDI ports and tries to identify the connected control surfaces. Note that not all control surfaces support auto-detection.

3. To add a control surface manually, click the Add button.
   This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
   If you can’t find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
   If you can’t find it on the menu, see below.
6. **An image of the selected control surface model is shown, often along with some information text - read this carefully.**
   For some control surfaces, you need to select a specific preset to use the surface with Reason - this is noted here.

7. **Use the MIDI Input pop-up to select the input port to which you have connected the surface.**
   If in doubt, you can click the Find button and then tweak a control or play a key on the control surface to have Reason find the correct input port for you.
   - **Some control surfaces may have more than one MIDI Input pop-up menu.**
     You need to select ports on all MIDI Input pop-up menus.
   - **Some control surfaces will have a MIDI Output pop-up menu.**
     In some cases this labeled “Optional” - then you don't have to make a selection. In other cases, a MIDI Output is required. This is the case if the control surface uses MIDI feedback - motor fader, displays, etc.

8. **If you like, you can rename your control surface in the Name field.**

9. **Click OK to add the surface.**
   Depending on the surface model, alerts may appear, reminding you to select a specific preset etc. In some cases, Reason can restore a preset in the control surface to factory settings for you - you are then informed of this.

Finally you return to the Keyboards and Control Surfaces Preferences page, where your added surface is now listed.

**If your control surface model isn't listed**

If you can't find your control surface listed on the Manufacturer or Model pop-up menus when you try to add it, this means that there's no native support for that model. However, the program supports generic keyboards and controllers. Here's what to do:

- **Select “Other” on the Manufacturer pop-up menu and then select one of the three options on the Model pop-up menu.**

or, if the Manufacturer is listed but not your specific model:
Select one of the three “Other” options on the Model pop-up menu:

In both cases, the options are:

- **MIDI Control Keyboard**
  Select this if you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set up your MIDI control keyboard so that the controllers send the correct MIDI CC messages, depending on which Reason device you want to control - check out the MIDI Implementation Chart in the Reason documentation. If your control surface has templates or presets for different Reason devices, these can be used.

- **MIDI Control Surface**
  Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without keyboard). Again, you need to set your controllers to send the correct MIDI CCs.

- **MIDI Keyboard (No Controls)**
  Select this if you have a MIDI keyboard without programmable knobs, buttons or faders. This is used for playing only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot adjust Reason device parameters with this type of control surface.

- **MIDI Multichannel Control Keyboard/Surface**
  These options can be used if your MIDI keyboard or surface can handle multiple MIDI channels simultaneously.

After selecting a model, proceed with selecting MIDI input as described above.

**About the master keyboard**

One of the control surfaces can be the master keyboard. This is like any other control surface, but it must have a keyboard and it cannot be locked to a specific Reason device (in other words, it always follows the MIDI input to the sequencer). This is the surface you use to play the instrument devices in Reason.

- **The first surface with a keyboard that is added (or found by auto-detect) is automatically selected to be the master keyboard.**
  This is shown in the Attached Surfaces list on the Preferences page.

- **If you want to use another surface as master keyboard, select it in the list and click the “Make Master Keyboard” button.**
  You can only have one master keyboard.

- **If you don’t want to use any master keyboard at all, select the current master keyboard surface and click the same button (which is now labeled “Use No Master Keyboard”).**

**Master Keyboard Input**

This allows you to set a preference for how Master Keyboard Input mode is selected:

- **Standard mode**
  This always sets Master Keyboard Input to the selected track.

- **Separated mode**
  This will allow you to independently select tracks while Master Keyboard Input is unchanged. If this is selected, Master Keyboard Input is set by clicking the device icon in the track list. Selecting another track (by clicking on the track name or somewhere in the track list), leaves Master Keyboard Input unchanged.
Other functions

> To edit a surface, double click it in the list (or select it and click Edit).
This lets you change its name and MIDI port settings, if needed.

> To delete a surface, select it in the list and click Delete.

> You can turn off a surface by deactivating its “Use with Reason” checkbox.
This could be useful if the surface is connected to your system but you only want to use it with another program, etc.

> There is also an “Advanced Control” page in the Preferences.
This is only used for External Control MIDI buses and for MIDI Clock Sync input. All hands-on MIDI control is set up on the Keyboards and Control Surfaces page.

Setting up the Default Song

Every time you start Reason, a simple default song opens. This default song contains a few devices and sequencer data and can be played. Every time you select “New” from the File menu, a default “template” song (without sequencer data) is opened, with a few selected devices. This serves as a suitable starting point for creating your own songs.

You can however decide exactly what you want the default song to look like, in the following way:

1. Open the Preferences dialog from the Edit menu (or Reason menu if you are running Mac OS X).

2. Use the pop-up menu at the top of the Preferences dialog to select the General page.

3. At the middle of this page, there is a section entitled “Default Song”.
You have three choices: “Empty Rack”, “Built In” and “Custom”.

Select which one you want to use by clicking the corresponding radio button.

- Empty Rack - This is an empty rack. Well, almost empty, since it contains the Reason hardware interface.
• Built In - When this is selected, launching Reason will open a basic demo song. Selecting “New” from the File menu will open a template song with a few devices to start with, but no sequencer data.
Note that it is not possible to open these songs by regular means - via the browser - since they are not “independent” .rns-files, and thus do not reside anywhere in the Reason folder.
• Custom - This allows you to select a custom default song. Any Reason song can be used, so if you often create songs using the same or similar device setups, you can use a previously created song as the default song. This way, all new songs you create will have the same device setup.

To select a custom default song, click the Folder icon to the right and browse to the desired Reason song.
The name of the selected song will then be displayed in the text box.
About this Chapter

This chapter is a quick introduction to the basics in Reason, laid out as a “guided tour”, describing the different areas and devices in the program.

! **Before you proceed with the tutorials, you should have connected your equipment and made settings for audio and MIDI as described in the previous chapters.**

On the following pages you will find a brief introduction of the program. This helps you get familiar with the different devices and their uses.

Guided Tour

The Rack

This is the virtual rack, the heart of Reason. At the top of the rack you will always find the Hardware Interface, which allows Reason to communicate with the audio hardware. Below this, you can add as many different devices you want (or as many as your computer can handle). Read more about the different devices below.
The Back

If you press [Tab] or select Toggle Rack Front/Rear on the Options menu, the rack will be “turned” to show you the back.

Here, the back panel of each device in the rack is shown. As you can see, connections between devices are indicated by “virtual patch cables”. Connections between instrument devices and mixers use red cables, connections to or from effect devices use green cables, connections to or from Combinator devices use blue cables and CV connections (Control Voltage, used for controlling parameters or triggering sounds) use yellow cables. You can make connections by clicking and dragging from one “socket” to another on the back panels.

To turn the rack over again (to show the front panels), use the same command.

The Transport Panel

The panel at the bottom of each song document window is called the Transport Panel. It contains transport controls and settings such as tempo and position displays, DSP load indicator, etc.
The Sequencer

The sequencer is located in the area below the rack. This is where you record and edit notes, controllers, device parameter automation and pattern changes.

The left part of the sequencer area is the track list, showing the names of the sequencer tracks. To the left in the list, a small image of the device the track belongs to is shown. There can never be more than one track for a specific instance of a device, but a track can have any number of “lanes” containing note and automation data. In the track list you can mute or solo whole tracks, mute individual lanes, add or remove lanes etc.

The track list.

The right part of the sequencer area has two main modes, the arrange view and the edit view.
When the arrange view is selected, you will see the tracks lined up vertically, with any recorded note events contained in clips. A ruler at the top of the view shows the meter positions.

The sequencer with the arrange view selected.
You can also view and edit the data events contained in the clips on a track - this is done in the Edit view. In the Edit view, data is always shown for one track at a time. For instrument tracks, clip events on one selected note lane will be shown at a time (you can have multiple note lanes on an instrument track). A note lane will also contain several edit lanes, showing the recorded data in detail. There are specific edit lanes for editing notes, velocity and performance data. You will also be able to view and edit any recorded parameter automation data for the track.

The Edit view, with separate drum, velocity, pattern and two controller edit lanes visible.

The Tool window

The Tool window provides a quick and convenient way of adding devices, editing/scaling data or adjusting groove parameters. The window can display one of four pages; the Devices Palette page (which contains all available devices in Reason), the Sequencer Tools page, the Groove Settings page and the Song Samples page. The window “floats” above the application. You can show/hide the Tool window by pressing [F8] or selecting Show/Hide Tool window from the Window menu.
The Devices

The following devices are available in Reason:

**Reason Hardware Interface**

This device handles Reason’s communication with your audio (and MIDI) hardware.

The Hardware Interface contains audio input and output indicators as well as sampling input indicators with level meters. This is where you connect different devices to different outputs on your audio hardware. This is also where you can route external input signals for real-time audio processing – or route external or internal audio signals for sampling. Reason supports up to 64 separate audio inputs and 64 audio outputs. However, if you are only using audio hardware with standard stereo outputs, the connections to the audio hardware are automatically taken care of when you create a mixer device at the top of the rack.

The lower half of the hardware interface (opened by clicking the “Advanced MIDI” button) contains settings for MIDI input, allowing you to select a separate MIDI channel for each device when controlling Reason from an external multi-channel MIDI source. Normally you should not have to use this.

**For standard MIDI control of one device at a time in Reason, you don’t need to use the hardware interface (since the MIDI signals are routed through the sequencer, as described in the tutorials following this chapter).**

**The Reason Hardware Interface is “riveted” into the rack, and cannot be removed.**

**Combinator**

The Combinator allows you to create new “custom” devices by combining existing devices. Any combination of Reason devices can be added to the Combinator and then saved as a “Combi” patch. Example usage includes creating layered instruments, instrument/effect combinations and effect chains. Devices in a Combi can be mapped to velocity/key zones and the Combinator also features virtual knobs and buttons that can be assigned to any device parameter or function.
Mixer 14:2

This is a mixer with fourteen stereo channels, four stereo effect sends and a basic two-band EQ section. By connecting the different devices to different mixer channels (and the stereo output of the mixer to the hardware interface) you can listen to all your devices at the same time, adjust levels and pan, add effects and so on - just like on a physical mixer.

Line Mixer 6:2

This is a simple mixer with 6 stereo channels and one stereo effect send/return. It can be used in situations where basic mixing facilities will suffice. Ideal for mixing device outputs within Combinator patches.

Subtractor Analog Synthesizer

The Subtractor is a polyphonic synthesizer laid out much like an advanced analog synth. It features two oscillators, two filters and a host of modulation functions, allowing for everything from fat basses to swirling pads and screaming lead sounds.
Thor Polysonic Synthesizer

Thor is an advanced semi-modular polyphonic synthesizer based on various selected vintage synth designs. It features several different oscillator and filter-types which can be loaded into open “slots”, allowing for an incredible tonal variety. It also has an extensive modulation section and an advanced “analog-style” Step Sequencer.

Malström Synthesizer

The Malström is a polyphonic synthesizer featuring two oscillators, two modulators, two filters, a wave-shaper and a large number of modulation and routing options. It is based on the concept of Grainable Synthesis and makes it possible to produce amazingly abstract, sharp, distorted, undulating sounds.
NN-19 Digital Sampler

The NN-19 allows you to sample and to load samples (Wave, AIFF, SoundFonts or REX files) and create multi-sample patches by mapping samples across the keyboard. Once you have loaded one or several samples, you can modify the sound using synth-type parameters such as a filter, envelopes and an LFO.

NN-XT Digital Sampler

The NN-XT - just like the above mentioned NN-19 - lets you sample and load samples (Wave, AIFF, SoundFonts or REX files) and map these across the keyboard to create multi-sample patches. The sound can then be modified using synth-type parameters; two LFOs, two envelopes and a filter.

In addition, the NN-XT also allows you to create layered sounds, where two or more samples can be played simultaneously. This is done by mapping different samples across the same keyboard range. Another useful feature is the possibility to set up velocity switched key maps.
**Dr. Octo Rex Loop Player**

The Dr. Octo Rex Loop Player plays REX files - audio files created in ReCycle, another Propellerhead Software product. ReCycle is a program designed especially for working with sampled loops. By "slicing" a loop and making separate samples of each beat, ReCycle makes it possible to change the tempo of loops without affecting the pitch and to edit the loop as if it were built up of individual sounds.

After loading one or several REX files into the Dr. Octo Rex Loop Player, you can play them back in virtually any tempo, make settings for individual slices, extract MIDI playback data and process the loops with the built-in filter, LFO and envelopes. You can also play the individual slices via MIDI or from the sequencer - each slice has a specific note number (C1 for the first slice, C#1 for the next and so on). A number of REX files are included in the Reason Factory Sound Bank.

**Redrum Drum Computer**

The Redrum is a sample-based drum machine with ten drum sound channels. You can sample and load samples (Wave, AIFF, SoundFont files and REX slices) individually for each channel, or open patches, which are complete drum kits (a number of which are included in the Reason Factory Sound Bank). Each sound channel has settings for pitch, level, velocity response, etc.

There is a built-in pattern sequencer, allowing you to create classic drum machine patterns, complete with shuffle and flam options. It is also possible to use Redrum as a sound module, playing it live from an external MIDI controller or from the main Reason sequencer. You may for example have the pattern sequencer play a basic drum pattern, and add fills and extras in the main sequencer. As with the Dr.Rex loop player, each drum sound has a specific note number (C1 for drum sound 1, C#1 for drum sound 2 and so on).
The Kong Drum Designer is an advanced drum sound module with 16 drum sound channels. You can sample and/or load samples (Wave, AIFF, SoundFont files and REX files) individually for each channel, or open patches, which are complete kits (a number of which are included in the Reason Factory Sound Bank).

Each sound channel can consist of one out of several different types of drum sound modules, including Sample Player, REX Player, Physical Modeling modules and Drum Synth modules. You can also add two additional “insert FX” modules to each drum sound channel. The effects can be additional sound generators or various types of effects. The Kong Drum Designer also features a Bus FX and a Master FX for each Kit.

The Kong Drum Designer should be used as a sound module, which you can play live from an external MIDI controller and/or from the main Reason sequencer. The 16 pads can be assigned in a number of different ways to allow for maximum flexibility.

**MClass Mastering effects**

The MClass Mastering effects consists of four high quality sound processors, suitable for (but not in any way restricted to) use as mastering effects, i.e. to process the final mixed output from Reason. The MClass effects can selected as a Combi (with all four effects chained), or as individual effects. The Factory Sound Bank contains MClass Combi patches with settings optimized for various mastering and sound enhancement applications. The MClass series of effects consists of the following devices:
• **MClass Equalizer**

This is a two-band fully parametric equalizer, with added high and low shelving bands and a low cut (rumble) filter. In addition there is a curve display giving graphic feedback of your settings.

• **MClass Stereo Imager**

This device splits the signal in low and high frequencies (user definable), allowing you to adjust the stereo width independently for the low and high bands. A typical application is to make the high band wider, and the low band more narrow (mono).

• **MClass Compressor**

This is a single-band compressor with features such as sidechain input, “soft knee” compression, and adaptive release. It also differs from the COMP-01 in that it doesn't have automatic make-up gain, allowing for other applications than simply keeping the level even.

• **MClass Maximizer**

This is a loudness maximizer, allowing you to significantly raise the perceived loudness without risking clipping distortion. It consists of an input gain section, a limiter section (with a "look ahead" function), a soft clip section and a level meter.

**BV512 Vocoder**

The BV512 is an advanced vocoder device with a variable number of filter bands and a unique 1024-point FFT vocoding mode (equivalent of 512-band vocoding) for very precise and high quality vocoded speech. By connecting the BV512 to two instrument devices, you can produce anything from vocoded speech, singing or drums to weird special effects.
Scream 4 Sound Destruction Unit

This is an extremely versatile sound destruction device, featuring various kinds of distortion, signal warping and transformation effects. There are three main sections: “Damage” (where you select a sound mangling algorithm and make settings), “Cut” (a three band EQ) and “Body” (a resonant body or cabinet simulator, excellent for making the sound come alive).

RV7000 Advanced Reverb

The RV7000 is a high quality reverb processor with nine different reverb and echo algorithms, ranging from rooms and halls to special effects. The RV7000 also contains an equalizer and a gate section, making it possible to get virtually any kind of reverb character, including gated reverb.

RV-7 Digital Reverb

This is a reverb effect with ten different reverb algorithms, ranging from hall and room simulations to special effects. You can fine-tune the effect with the knobs on the device panel if you like. The reverb is normally used as a send effect.

DDL Digital Delay Line

This is a basic digital delay, useful for echoes, slapback, doubling, etc. The delay time can be set in steps based on and synchronized to the current song tempo, or in milliseconds for free-running delays. The maximum delay time is 2.0 seconds.
D-11 Foldback Distortion

The D-11 is a simple but highly effective distortion device, that can convert mellow synth sounds to screaming leads and basses, add grit and dirt to drum patterns or loops, etc.

ECF-42 Envelope Controlled Filter

This is a synth-style resonant filter with three different filter modes. You can either use it as a "static" filter (and vary the filter frequency on the device panel, or via Control Voltage from another device) or use the built-in envelope to create rhythmic filter effects of various kinds. The envelope can for example be triggered by a drum machine or the Matrix pattern sequencer.

CF-101 Chorus/Flanger

The CF-101 does double duty as chorus (for making textures rich and swirly) and flanger (for creating sweeping, metallic effects). You can use it as a send effect or as an insert effect (connected between an instrument device and a mixer).

PH-90 Phaser

The PH-90 is a stereo phaser effect. It has six parameters available on the device panel, allowing you to create both subtle sweeping sounds and extreme, swirling special effects.

UN-16 Unison

The UN-16 simulates the sound of several detuned voices playing the same notes simultaneously, producing a rich chorus-like effect with the voices spread across the stereo field if you like.
COMP-01 Compressor

This is a combined compressor and limiter. It will affect the dynamics of the sound, by boosting low levels and attenuating loud sounds. Use it for keeping levels even (from individual devices or the whole mix), for adding punch and power to drums, etc.

PEQ2 Two Band Parametric EQ

While the mixer device has basic two-band EQ on each channel, sometimes you may need some more precise control over the tone color. For this purpose, you can use the PEQ2. This device contains two independent parametric equalizers, with controls for frequency, gain and Q value.

Spider Audio Merger & Splitter

This is not an effect device, but a utility. With the Spider Audio you can merge up to four audio input signals into one output, as well as split one audio input signal into four outputs. This makes audio signal routing much more flexible and allows for very creative patching.

Spider CV Merger & Splitter

Again, this is not an effect device, but a utility. With the Spider CV you can merge up to four CV input signals into one CV output, as well as split CV or Gate inputs into several outputs (one of which can be inverted). One use for the Spider CV is to split Gate and Note CV to control several instrument devices with one Matrix.
The Matrix Pattern Sequencer

The Matrix is a stand-alone pattern sequencer, somewhat similar to a vintage analog sequencer. A Matrix pattern can have between 1 and 32 steps, and for each step you can specify which control voltage levels should be sent out from the three separate CV outputs on the back of the device. If you like, you could view this as having three separate pattern sequencers in one.

By connecting the Matrix to e.g. a synth device, you can have the pattern sequencer play the device (for a repeating synth pattern), or control various parameters, for rhythmic effects that you cannot obtain using the synth device alone.

RPG-8 Monophonic Arpeggiator

An arpeggiator generates rhythmic note patterns (arpeggios) from notes or chords. Similarly to the Matrix, connecting the RPG-8 to e.g. a synth device, means the arpeggiator can play the device (for a repeating arpeggio), or control various parameters. The RPG-8 Arpeggiator has innovative features like musically logical pattern variations and a Pattern editor for even more rhythmic variation.

ReBirth Input Machine

This device allows you to use Reason in conjunction with Propellerheads' classic ReBirth application. The audio from ReBirth will be “streamed” via the ReWire protocol into Reason. By routing the different outputs on the ReBirth Input Machine to different mixer channels, you can mix the sound of ReBirth with the sound of Reason, add effects to separate ReBirth sounds, etc.
Chapter 4
Tutorial 1 - Playing a Song
About this tutorial

This and the following chapters are written in tutorial form to introduce you to some of the basic operations in the program. So if you are new to Reason and wish to get started quickly this is where you should start!

In this first tutorial we shall go over the following:

- How to open and play back a song
- Basic mixer operations.

! This tutorial assumes you have made the necessary setting up for audio. If not, please refer to the “Setting Up” chapter before starting.

Playing a Song

1. If you haven’t launched Reason yet, do so.

2. Pull down the File menu and select Open.
   The Song browser window opens were you can open Reason song documents. It shows the contents of your hard drive as a standard folder structure much like Windows Explorer or the Finder in Mac OS X, but only Reason Song document files can be shown/opened.

3. Navigate to the Reason program folder.
   This can be found in the Locations and Favorites list in the upper left corner of the browser.

4. Select the song “Tutorial Song.rsns”.

5. Click Open.
   The document window for the song is displayed on screen. This consists of a "virtual rack” with devices (this song contains four instrument devices and two effects), a sequencer section and a transport panel.

6. Click the play button on the transport panel (at the bottom of the window).
   Playback starts. If everything is properly connected, you should now hear Reason play!

7. Click the stop button to stop playback when you’ve heard enough.
   Now, try out some real-time mixing:

8. Click the stop button again.
   This moves the song position to where you last started playback. In this case, this will be the start of the song, allowing you to play the song from the beginning again.
9. **Near the top of the rack is a mixer device - make sure this is visible.**
   You may need to scroll the view using the vertical scrollbar to the right in the rack (or the scroll wheel on your mouse, if it is equipped with one).

![The Mixer.]

If you look at the mixer, you will see that each mixer channel has a “tape strip” next to the volume fader. If a device is connected to a mixer channel, the tape strip is labeled with the device name. In this song, there are only four instrument devices, so only the four first mixer channels are labeled.

![The scrollbar.]

10. **Click the play button to start playback.**

11. **While the song is playing, click and drag the faders to adjust the level of each instrument device.**

12. **Try changing the pan setting (stereo position) of a channel, by clicking the pan knob above the fader and dragging up or down.**
   Dragging up will turn the knob clockwise; dragging down will turn it counter-clockwise.

![Dragging the pan knob.]

You may also want to add some effects to the music. In this song, there are two effect devices connected: a delay and a chorus/flanger. These are connected as send effects from the mixer, allowing you to specify how much of each mixer channel signal should be sent to each effect.
13. Raise the Aux send level knobs at the top of a mixer channel.
   Send 1 is connected to the delay, while send 2 goes to the chorus/flanger.

Now, let’s try tweaking some controls on an actual instrument device, to change the sound. In this example we will use the Subtractor synthesizer device, but all devices have parameters that can be adjusted on the device panels in the same way.

Unless you have a very large screen, the Subtractor device isn’t visible right now. You could use the scroll-bar to scroll the rack down, but here’s a quicker way:

14. In the sequencer area (above the transport panel), click on the name “Subtractor” in the track list to the left.
   The rack is automatically scrolled to bring the Subtractor device into view.

15. Try adjusting some parameters while the song is playing.
   You may for example want to tweak the “Filter 1 Freq” slider, to change the brightness of the synth bass sound.

That concludes the first tutorial.
Chapter 5
Tutorial 2 - Playing devices and selecting sounds
About this tutorial

In this second tutorial we will go through the following basics:

- How to add a mixer device and an instrument device.
- How to direct MIDI to an instrument device so you can play it.
- How to browse for and select a patch for an instrument device.
- How to add an effect.

! This tutorial assumes you have made the necessary setting up for MIDI and audio. If not, please refer to the “Setting Up” chapter before starting.

About devices

Reason devices can be divided into the following main categories:

- **Instrument devices**
  These are playable devices that are handled like an instrument - i.e. notes played on your master keyboard will play the instrument device.

- **Effect devices**
  These are used to process sound.

- **Other devices**
  These include Mixer devices (for mixing audio signals), Pattern devices (which can be used to program patterns that can trigger notes in instrument devices), and Utility devices (these can split and merge signals in various ways).

Adding a mixer and an instrument device

This first section of the tutorial describes how to add a mixer device and an instrument device to the rack. We’ll start with an empty rack to show you how it is done from “scratch”.

1. **If you like, close the current song by selecting Close from the File menu.**
   You can have several song documents open in Reason at the same time, but each song uses some memory and computing power, so it’s good practice to close songs you don’t need. Note that on the Windows platform, closing a song when there are no other songs open will also cause the program to quit.

2. **Pull down the File menu and select Open.**

3. **Navigate to the Reason program folder and open the Template Documents folder.**

4. **Select the file “Empty Rack.rns” and click Open.**
   A song document window appears. This consists of an (almost) empty rack and one track in the sequencer; the Transport track, which is always present. To the right of the rack is the Tool window which can display various pages for editing or adding devices etc.

- **Normally when you create a new song, you would select “New” from the File menu. This command opens the default song, which contains a mixer and a Combinator device loaded with some mastering effects, which is a perfect starting point for adding instrument devices and getting started with your song.**
  For the purpose of this tutorial however, we will start with an empty rack.
You can also customize what song should open when you select “New” from the File menu. This is described on “Setting up the Default Song” on page 25.

5. In the Tool window, make sure that the “Device Palette” tab is selected and that all device categories are ticked (Instruments, Effects and Other).

Now the Devices page is shown, displaying all available Reason devices.

6. From the device list select Mixer 14:2 and then click “Create” at the bottom of the list. A mixer device is created in the rack. You can also click and drag devices directly into the rack or double-click a device in the list to add it.

- Sequencer tracks are not automatically created for new mixer (or effect) devices. Currently there are only two sequencer tracks named “Blocks” and “Transport” present in the Track List. The Transport Track is always present in the sequencer and is used for automating tempo and time signature changes, but this will not be covered in this tutorial. The Blocks Track is present when the Blocks function is active on the Transport Panel and is used for automating playback of Blocks - shorter sections of a song. The Blocks function is not covered in this tutorial but is described in detail in the Reason Operation Manual.

! The reason why you should start with a mixer device, is that all subsequent instrument devices you add to the rack will then automatically be connected to a mixer channel. In other words, whatever further instrument devices you add, the device output(s) will automatically connect to this mixer. This will be true until you run out of channels in the mixer - in this case 14 stereo channels. When this happens you can create more mixer devices and “chain” them so there is never any risk of “running out” of mixer channels.

7. Select “Subtractor Analog Synthesizer” from the Devices page and click “Create”. A Subtractor synthesizer device is added to the rack and if you look in the sequencer a track has automatically been added for the device.
In the sequencer, the synthesizer track is automatically selected (as you just created the device), and Master Keyboard Input will be routed to this device. When a device icon to the left in the track list is surrounded by a red border and has a keyboard symbol this indicates that the track has master keyboard input. This means that notes you play on your master keyboard will be sent to that sequencer track and to its device in the rack. By default, master keyboard input always follows the selected track.

8. Press the [Tab] key, to show the back of the rack.
As you can see, the output from the Subtractor has a cable connected to the first channel of the mixer, and the mixer output has cables connected to the Hardware Device where audio signals from Reason are sent to your audio interface. These connections were made automatically when you created the devices.

9. Press the [Tab] key again to flip the rack back to show the front panel.

10. Try playing your MIDI keyboard.
What you will hear is the default patch of the Subtractor, which may not be what you want. All new instrument devices will open with a default patch loaded. (This behavior is however a user selectable preference - see below.)

If you don't have a MIDI keyboard at hand, you can press [F4] to bring up the On-screen Piano Keys window. From this window you can play the devices either by clicking on the on-screen keyboard on the Mouse tab, or by using the computer keyboard on the Computer Keyboard tab. Refer to the Operation Manual for more details about the On-screen Piano Keys window.

11. To browse for a suitable patch see “Selecting a patch” below.

About the “Load Default Sound for New Devices” Preference
On the Preferences - General page you have the option of selecting whether new devices should open with a default patch or not. In this manual we assume the option “Load Default Sound for New Devices” is activated. This is also the default mode.
Selecting a patch

Patches are loaded from the Patch browser. To select a patch, proceed as follows:

1. **Click the Browse Patch (folder) button on the Subtractor panel.** This opens the Patch browser dialog. By default for a new Subtractor device, the folder “Subtractor Patches” of the Reason Factory Soundbank will be shown. This folder contains a number of sub-folders with different patch categories.

2. **Open one of the folders, and select a patch, but do not close the browser window.** The patch is loaded in the background - you can now try out the patch while playing your keyboard.

3. **Try auditioning other patches in the browser.** When you have found a patch you like, click OK to close the browser.

   ➔ **Once you have selected a patch this way, you can step between the patches in the same folder, by clicking the up and down arrow buttons next to the patch display.** Alternatively, you can click in the patch name display to bring up a context menu with all the patches in the folder. The browser will now remember this location so the next time you open the patch browser for this instance of the instrument.

   ➔ **The basic procedure of browsing and selecting patches is the same for all instrument devices.** All devices that use patches have a Patch name display, a Browse Patch (Folder) button for opening the Patch browser, Up/Down arrow buttons and a Save Patch button (floppy disk icon).
Adding an effect

Next, let's add an effect to the synth device. Effects can be used in two basic ways:

- **As insert effects.**
  This means the effect is connected between the instrument device and the mixer. You use an insert effect when an instrument device should have its own separate effect (and, typically, when you want to hear the effect sound only, no “dry” sound).

- **As send effects.**
  This way you connect an effect to the Aux send and return busses on a mixer. You use send effects when several instruments should have the same effect (and, typically, when you want to hear a mix between the dry sound and the effect sound). You control the effect amount by using the Aux knobs for mixer channels (as illustrated in the first tutorial). Typical send effects are reverb and delay.

In the first example, we will describe how to connect a Unison effect device as an insert effect for the Subtractor:

1. **Click somewhere on the panel (not a button or slider) of the Subtractor device in the rack to select it.**

2. **In the Tool window, untick the “Instrument” and “Other” device categories so that only the “Effects” category is ticked.**
   Only effect devices will now be shown.

3. **Double-click the “UN-16 Unison” device.**
   The effect is created and appears below the Subtractor in the rack. If you flip the rack around (by using the Tab key), you can see that the output of the Subtractor is now connected to the effect, and that the effect's stereo outputs are routed to a channel in the mixer.

4. **Flip the rack back to show the front panel.**

5. **If you now play you should hear the Subtractor being processed by the effect.**
   You can turn up the “Detune” knob for a stronger detune effect if you like.

6. **By using the “Dry/Wet” knob, you can adjust the balance between the clean (Dry) signal and the effect (Wet) signal.**
Now we will apply the same effect, but this time as a send effect:

1. **Delete the Unison device you just created by selecting it in the rack (click somewhere on the panel to select it) and then pressing [Backspace]**
   The effect will be deleted and the cable routing will be restored to exactly how it was before creating the effect. You can also delete devices from the context menu which is opened by right-clicking/[Ctrl]-clicking (Mac OS) on the effect panel.

2. **Select the mixer by clicking on the panel.**

3. **Double-click the “UN-16 Unison” device in the Tool window.**
   The effect appears below the Mixer in the rack. If you flip the rack around (by using the Tab key), you can see that the Aux 1 Send Out is connected to the effect’s input, and the effect stereo output is connected to the Aux 1 Left/Right Return sockets.

4. **Flip the rack back to show the front panel.**
   The first tape strip in the Effect Return section of the Mixer now indicates that a Unison device is connected to the Aux 1 Send/Return bus.

5. **Now turn up the Aux 1 knob for the Subtractor mixer channel and play a few notes.**
   The Aux 1 knob now controls the level of the Unison effect. When using send effects, you should always leave the Dry/Wet parameter on the effect device to maximum Wet as the Aux knob now controls the balance between clean and effect signal. Also note that any device connected to the mixer can now be processed by the Unison effect - simply turn the Aux knob for the corresponding channel to add the effect.

That concludes the second tutorial! If you want to go on to the next tutorial straight away, you can keep the current song open.
Chapter 6
Tutorial 3 - Creating a drum pattern
Creating a drum pattern

In this tutorial we will describe how to create a drum pattern using the Redrum device. If you have kept the song from the previous tutorial open, you can skip the first step.

1. **Select “New” from the File menu.**
   This will open a new song, which by default is configured with a Combinator effect patch named “Default Mastering Suite”, and a mixer device.

2. **Select “Redrum Drum Computer” from the Create menu.**
   In the sequencer, a track for the Redrum is created. It is automatically selected and gets master keyboard input.

3. **Click the folder button in the lower left corner of the Redrum panel.**
   This opens the patch browser for the drum machine, allowing you to select a Redrum patch (a drum kit). Note that there are folder buttons for each drum sound channel too - these let you add drum samples one by one and create your own drum kits.

4. **Select a Redrum patch in the same way as you selected a Subtractor patch in the previous tutorial.**
   The patches are located in category folders within the folder “Redrum Drum Kits” in the Reason Factory Sound Bank - this main folder is opened by default.
When you have selected a patch, you will note that a sample file name is displayed at the top of each drum sound channel in the drum machine. There may also be different parameter settings for the different drum sounds - all these settings are part of a Redrum patch.

5. Try out the drum sounds by clicking the audition buttons at the top of each drum sound channel.

Now, let's start building a pattern. By default, the empty patterns have sixteen steps, with each step corresponding to a sixteenth note (so that the length of a pattern is one 4/4 bar). To make things simple, we'll keep this setting for now.

6. Click the Run button on the Redrum device panel.
   The pattern will start playing (as indicated by the running “LED” on the step buttons at the bottom of the device panel). Nothing will be heard, since you haven’t added any drum beats yet.

7. Click the Select button for one of the drum sounds.
   In Redrum, you add drum beats for one sound at the time.
8. **Click on the first step button (marked 1).**
   The button lights up, indicating a drum beat.

   ![Diagram of a drum pattern editor with a lit button]  
   You will now hear the sound of the selected drum on the first beat of each bar.

9. **Add more drum beats by clicking other step buttons.**
   Clicking a lit step button will remove the beat for the corresponding step.

   ➤ You can add beats of different strength (velocity level) by adjusting the Dynamic switch. Exactly how each sound is affected by different velocity levels depends on the settings. You can also adjust the dynamics “on the fly” by pressing [Shift] or [Option] (Mac) / [Alt] (Windows) when you add beats. [Shift]-click for hard beats, [Option]/[Alt]-click for soft beats.

   ![Diagram of a dynamic switch with options for hard, medium, and soft]  

10. **Select another drum sound (by clicking its Select button) and proceed in the same way until you have a drum pattern you want to use.**

11. **To stop the playback, click the Run button again.**

    That concludes the third tutorial!

    In the following tutorial, we will describe how to add a bass line to the current drum pattern so you can leave the current song open. Alternatively, save it in a location of your choice under a suitable name by selecting “Save as” from the File menu.
Chapter 7
Tutorial 4 - Recording a bass line
About this tutorial

In this tutorial we will go through the following basic procedures:

- How to browse for a specific type of patch.
- How to record notes in the sequencer.
- How to copy a clip in the sequencer.

This tutorial assumes that you have followed the previous tutorial(s).

You should have a song open, containing a mixer device and a Redrum device with the drum pattern you programmed in the previous tutorial. If you kept the same song open for all tutorials you also have a Subtractor device.

If you saved the previous tutorial and closed it, select "Open" from the File menu, navigate to the saved song and open it.

Browsing for a bass sound

Browsing for a patch was covered in the previous tutorials.

In this instance we will use "cross-browsing" which means you can browse and audition patches for all Instruments, regardless of whether the instrument exists in the current song or not. In addition, we will browse for a specific type of patch; a synth bass sound.

It doesn’t matter what track is selected when you use this feature, you will automatically get Master Keyboard Input when cross-browsing.

It works as follows:

1. Select “Create Instrument...” from the Create menu or use the corresponding button at the top of the Tool window - Device Palette page.

2. Double-click the “All Instrument Patches” folder in the browse list
   The browser will show all instrument patches divided into category folders.
3. Double-click the “Bass” folder to open it.  
   This folder contains 3 further sub-categories; Acoustic Bass, Electric Bass and Synth Bass.

4. Open the “Synth Bass” folder.  
   As you can see, the browser now not only displays Subtractor (zyp) patches, but patches for many different devices. For example, patches with the extension “.cmb” are Combinator patches, “.xwv” are Malström patches etc.

5. Move the browser window so that you can see part of the rack.

6. Select a Subtractor patch (extension “.zyp”) in the browser but do NOT click OK.  
   A new Subtractor device has been added to the rack and should be in view. The patch you selected can be auditioned if you play a few notes.

7. Keep an eye on the Subtractor device and use the “Select Previous/Next” buttons (or your up/down arrow keys) to step through the patches in the browser.  
   When you load a patch belonging to another instrument device, the corresponding device will replace the Subtractor device in the rack and allow you to audition the patch! Cross-browsing is a powerful feature that enables you to quickly search for a sound without having to create new devices or to open/close the browser etc.

8. When you have found a bass patch, click OK to close the browser.  
   A new corresponding sequencer track is added for the new instrument device.

   You can still access all the patches that were found when browsing (i.e. the patches in the “All Instruments/Synth Bass” folder).  
   This is either done by clicking in the Patch Name display and selecting from the pop-up menu or by using the Select Next/Previous arrow buttons beside the Patch Name display. Selecting a patch for another device will change the instrument instantly.
Recording notes in the sequencer

Now let's try adding a bass line to the Redrum pattern by recording notes in the sequencer.

1. **Select the track for the synth bass device in the sequencer track list.**
   It will automatically get Master Keyboard Input, as indicated by the keyboard symbol and the red frame surrounding the device icon.

2. **Start playback on the transport panel.**
   The Redrum drum pattern will start playing, and will repeat for as long as you are in play mode.

3. **Play the bass patch along with the drum pattern and check how it sounds.**
   If needed, you can slow down or speed up the song tempo by using the Tempo up/down arrow buttons on the transport panel.

   ➔ *Continue playing along and try to come up with a short 4 bar bass line that fits the drum pattern.*

   ➔ *If you would like a metronome click to help you keep time, press the Click button on the transport.*
   You can adjust the click level using the Click Level knob below the Pre button.

When you are ready to record your bass line, proceed as follows:

4. **Make sure the Left locator is at the start of the song.**
   It is by default set to 1.1.1. 0.

   ![The Left locator position is shown in the corresponding display to the right on the transport panel.](image)

5. **Set the Right locator to the position “5.1. 0”.**

You can set the Left or Right locator positions in several ways:

- **By clicking on the header of either the “L” or “R” locator and dragging (it will snap to exact bar positions).**

- **By clicking on the first digit of the locator position display on the transport panel and moving your mouse up and down.**

- **By clicking on the first digit and typing in the bar position for the locator position display.**

- **By clicking on the first digit and using the up/down spin controls beside the position display.**
6. Click stop on the transport until the song position is at the start of the song (1.1.1. 0).
   The first time you click stop, the song position cursor simply stops at the current position. The second
time the cursor moves to where it was last when starting playback (which could be at the start of the
song). The third time will move the cursor to the start of the song. You can also click the “L” button be-
side the locator position display to move the song position cursor there.

7. Click the “Loop” button on the transport so that the button lights up.
   If you now start playback, you can see that the first 4 bars as set with the Left and Right locators will
loop seamless. When the position reaches the Right locator it jumps back to the start of the song and
the Redrum pattern will play continuously.

8. Click Stop until the position is again at the start of the song.
   (See step 6.)

9. Activate pre-count by clicking the “Pre” button on the transport.
   This will sound the metronome click for 1 bar before the recording starts so you have time to get ready.

During recording, the 4 bar section will loop continuously (just as when playing back). Any notes played will
be recorded. This means if you play the complete bass line during the first “lap” of the 4 bar loop, you
should not continue to play the bass line on the second lap as these notes will be added to the previously
recorded notes. There is never any risk of erasing data when loop recording but everything you play or
tweak will be recorded.

10. Click the Record button on the transport panel.
    Recording will start after the 1 bar pre-count click.

11. Play your bass line along with the drum pattern.

12. When you’re done, click the stop button.
    A 4 bar clip containing the notes you played has been added in the sequencer.

13. Click stop again to move the song position to the beginning of the song.

14. Click play to listen to your recording.
    Stop playback when you are done.

Perhaps you want to record a new take, either just to improve the performance or simply because you
made a mistake. This can be done in several different ways which are described below.
About tracks, clips, lanes and recording takes

A Reason device can only have one track in the sequencer. A track can have any number of lanes. As illustrated previously, a recording produces a clip which is placed on a note lane for the corresponding track. This clip will contain the notes (and any performance data like pitch bend or mod wheel) you played when recording.

To record a new take of your bass line, you have three basic alternatives:

- **Select “Undo Record Track” from the Edit menu.**
  This will simply delete the clip you just recorded, allowing you to record a new take on the same note lane of the track.

  - You can undo and re-record until you are satisfied, but note that you will not be able to go back to a previous take after deleting its clip and recording a new take, so only use this method when you are sure you want to discard the previous recording - otherwise create an alternate take as described below.

  - If you record over an existing clip on the same lane without erasing it first, the new notes will be overdubbed on top of the old take - i.e. notes from both takes will be contained in the same clip and play back simultaneously, which is probably not what you want.

- **Create a new note lane for the track by clicking the “Alt” button to the right of the Record button on the transport.**
  This will mute the clip between the locators on the previous note lane, and create a new record-enabled note lane above it.

  - This is the method to use if you wish to record and keep a series of takes. You can use this basic method to record any number of takes and later play them back (one at a time) to decide which take is best (or edit together the best bits from several takes).

As you can see, the clip on the first note lane is muted, indicated by the grey stripes. The new note lane is directly above the first note lane and is record-enabled (indicated by the red Record button).

- **To compare between several takes, select the clip(s) you want to mute or unmute and choose “Mute Clips” or “Unmute Clips” from the Edit menu. To mute an entire note lane, use the Mute (M) button on the respective lane in the Track List.**

- **Create a new note lane for the track by clicking the “Dub” button to the left of the Alt button on the Transport Panel.**
  This will create a new record-enabled note lane above it, but will not mute the previous take. In other words, you will hear the previous take as you record.

  - This is the method to use if you wish to record additional notes to a previous take. You can also use the “Lanes +” button above the track list to create a new record-enabled note lane.
Using Quantize

You can quantize your recorded notes to “tighten up” the performance. The Quantize pop-up menu is located on the Tool window - Sequencer Tools page.

1. **Make sure the clip containing the bass line is selected in the main sequencer window.** Simply click on the clip so that you get black arrow “handles” at each end of the clip.

2. **Click on the “Sequencer Tools” tab in the Tool Window.** This page features various edit functions that can be applied to selected clips/notes. The top section is Quantize and the default setting is 1/16th note quantize, meaning that notes will be shifted to the closest exact 1/16th note position.

3. **Click the “Apply” button in the Quantize Notes section to quantize the recorded notes.**

4. **Play back your recording to audition the result.** If it sounds good, keep it. If it wasn’t what you expected, use the Undo function on the Edit menu to revert back to unquantized notes. You can select another quantize resolution, e.g. 1/8th notes from the Quantize section of the page and perform the operation again to check if this works better.

   ➤ You can also quantize notes as they are being recorded, by clicking the “Quantize During Recording” box in the Quantize Notes section in the Tool Window.

   ➤ Reason also features a powerful “ReGroove Mixer” function where notes can be quantized to fit a certain groove rather than to simply adapt to specific bar/beat increments. The ReGroove Mixer is described in the Operation Manual.
Copying and pasting a clip in the sequencer

So now you have a four bar bass line contained in a clip in the sequencer. Although the clip loops infinitely now, having the sequencer loop over just four bars is not something you usually do, as any further tracks you might add will then loop four bars as well, which is rather restrictive. The answer is to copy and paste the clip so that it repeats for a certain pre-determined length.

Proceed as follows:

1. **Select the clip by clicking on it in the arrange window.**
   Selected clips have handles at the start and end of the clip.

2. **Select Copy from the Edit menu.**
   The position cursor will automatically move to the end of the clip. The position cursor determines where the start of the copied clip will end up, and as we want the clip to repeat this is perfect.

3. **Select Paste from the Edit menu.**
   The clip is pasted at the end of the first clip and position cursor will move to the end of the copied clip.
   You can repeat the last step as many times you like to create a chain of clips.

4. **Click the Stop button to rewind the position to the start of the song.**

5. **Move the Right locator to the end of the last clip.**

6. **If you now press play on the transport the bass line will sound exactly the same as before in that the clip will repeat along with the Redrum pattern, but you now have a good starting point to continue editing or recording more etc.**
   For example, you could now edit the notes in one or more clips to create variations. How to edit individual note events for a clip in the sequencer is not covered in this basic tutorial, please refer to the Operation Manual.

That concludes the fourth tutorial. You can either keep things as they are and directly go on to the next tutorial, or you can save the song to enable you to continue later.
About this tutorial

! The following tutorial continues from the previous tutorials.

In this tutorial we shall cover the following:

- How to add a Rex loop.
- How to adjust parameters for the whole loop as well as for individual “slices”.

Adding a REX loop

About REX loops

In this tutorial we will add a REX loop to the existing song. REX loops are created in ReCycle, another Propellerhead application, but there are scores of ready made loops in the Factory Soundbank for you to use. REX files are audio files, usually 2 or 4 bars in length, that have been “sliced” in the ReCycle application. The resulting file allows you to change the tempo of your song, and the REX loop will automatically adapt to the tempo.

Any MIDI notes you have recorded (like your bass line) will of course also adapt to any tempo, but non-REX audio loops will not.

Adding a REX loop

REX loops can used with the NN-XT sampler, the Kong Drum Designer or the Dr. Octo Rex Loop Player. In this tutorial we will use a Dr. Octo Rex device. Proceed as follows:

1. **Double-click a “Dr. Octo Rex Loop Player” in the Tool Window - Device Palette page.**
   
   A Dr. Octo Rex loop player is created together with a corresponding sequencer track. A default loop is also loaded in Loop Slot 1.

2. **Click on the “Run” button so that it lights up.**
   
   The default loop starts playing. If the Run button is activated, you will also be able to audition loops in the browser at the current sequencer tempo.

3. **Unfold the Dr. Octo Rex Programmer by clicking the fold/unfold button at the bottom left.**

   The Programmer panel is shown.
4. Click the Browse Loop (folder) button on the Dr. Octo Rex Programmer panel to open the REX file browser.

In the main browser window you should now see three Dr. Rex folders; Drum Loops, Instrument Loops and Percussion Loops. As we already have a drum pattern, let’s try adding a percussion loop to the song.

5. Open the “Dr. Rex Percussion Loops” folder.

Various percussion instrument folders are listed. The folders also have a tempo listed in bpm. These tempo listings are merely suggested tempo values for the REX files contained in the folder. Any REX loop will sync to whatever song tempo is set on the transport, although some loops will sound more natural if they do not deviate too much from the original tempo.

6. Open a percussion instrument folder of your choice and select one of the loops inside.

Audition different loops in the folder by selecting them.

7. When you have found a loop, click OK to close the browser.

The selected loop continues to play and the display on the Dr. Octo Rex Programmer panel shows the waveform as well as the individual slices in the loop.

8. Click the Run button again to stop the loop playback.

9. To check out the loop together with the other devices’ previously recorded sequencer data, click the sequencer Play button.

This will automatically activate the Run button on Dr. Octo Rex and will make the loaded REX loop play back in perfect sync with the rest of the song.

10. Click Stop on the Transport Panel.

The loop stops together with the song.

The Dr. Octo Rex can hold up to eight REX loops at a time. If you want to load additional REX loops, just click another Browse Loop button as described in step 4 above and load another REX file.

- To switch playback between the REX loops, click the corresponding Loop Slot button on the main panel.

By default, the new REX loop in the selected Loop Slot will kick in at the next bar.

- If you want the loop switching to take place at the next beat or 16th note, click the corresponding Trig Next Loop button:
Adjusting Dr. Octo Rex parameters

You can tweak the REX loops in various ways using the Dr. Octo Rex Programmer parameters. Here follows a few examples:

- **While playing back the loop, try adjusting the Filter Freq parameter.**
  By lowering the frequency the loop is shaped through a low pass filter (by default). Raising the filter resonance (Res) slider will produce a sharper filter sound.

- **By using the Loop Transpose parameter you can transpose the whole loop up or down one octave (in semitone steps).**

- **If you adjust the “Slice” knob you can select an individual slice for editing.**
  A selected slice is highlighted in the display. The eight knobs to the right of the Slice button (Pitch, Pan, Level, Decay, Reverse, Filter Frequency, Alternate Group and Output) can be used to edit a single slice. For example, by adjusting the Pitch parameter, the selected (highlighted) slice will be transposed but not the other slices.

That concludes the fifth tutorial. You can either keep things as they are and directly go on to the next tutorial, or save the song to enable you to continue later.
Chapter 9
Tutorial 6 - Adding an arpeggio
About this tutorial

In this last tutorial we shall cover the following basic operations:

- How to create arpeggio patterns using the RPG-8.
- How to automate a parameter - see “Automating a parameter” on page 74.

The following tutorial continues from the previous tutorials.

Adding an arpeggio

The RPG-8 Arpeggiator is a device that generates patterns (arpeggios) from notes. It needs to be connected to an instrument device as it doesn’t generate sound on its own. You set it up as follows:

1. Create a new Subtractor device from the Device Palette.
   A Subtractor is added to the rack with its output auto-connected to the mixer.

2. Open the patch browser and double-click on the “MonoSynths” folder to open it.

3. Select the patch “Matrix3”.
   This is simply a patch with short attack/decay times, suitable for arpeggio playing.

4. With the new Subtractor device selected, create a RPG-8 Monophonic Arpeggiator.
   A sequencer track with MIDI input named “Arp 1” is created for the RPG-8. The RPG-8 Note and Gate CV outputs (on the back panel - use [Tab] to flip the rack) will be auto-routed to the Subtractor’s Sequencer Control Gate and CV inputs, so all connections needed are made automatically. The CV/Gate connections are a way to make one device control another. The Gate signal tells a device when a note should be played and the Note CV signal determines the pitch of the note.
5. **Flip the rack back and play a few chords.**
The notes in the chord you play are now arpeggiated for as long as you hold down the keys. The arpeggio will change directly if you release all notes and play another note or chord. If you add notes while holding down a chord, the arpeggio will continue with the added notes. The arpeggio will play in sync with song tempo by default in new RPG-8 devices.

⇒ **Try changing the arpeggiator mode using the Mode knob.**
The various modes govern how the notes are arpeggiated. For example “Up” means from lowest note to highest note, Up+Down from lowest to highest note, then back down to lowest note again.

- The Octave buttons set the octave range of the arpeggio.
  E.g. if set to 2 Oct the pattern will play over two octaves and so on.
- The Rate sets the rate of the arpeggio pattern - in the current Rate mode (Sync) the rate will sync to the sequencer tempo in various beat resolutions.

Experiment with these basic parameters if you like.

6. **Start playback and play suitable chords to accompany the song.**
As Loop is activated the set bars will repeat for as long you are in Play mode.

7. **To record the notes you play, press Stop, rewind to the beginning and make sure Pre-count (the “Pre” button on the transport panel) is activated.**
Pre-count was described in Tutorial 4 and should still be on.
Note that you have to enter the first chord after recording starts (i.e. when the one bar count-in is finished) - if you hold a chord and then enter record, the notes generating the arpeggio will not be recorded, although you can hear the arpeggio. This is because you are not recording the actual notes generated by the arpeggiator, only the notes you play.

8. **Stop recording, rewind to the top of the song and start playback.**
The arpeggio will now play back exactly as you heard it when recording. You can still change RPG-8 parameters freely. Changes will be reflected in the arpeggio although the recorded notes that generate the arpeggio will be the same.

⇒ **The RPG-8 has many more features not covered in this tutorial - please refer to the RPG-8 chapter in the Operation Manual for a full description of the RPG-8.**
Automating a parameter

Automation is a big part of Reason. Any parameter change can be recorded and edited as automation events. In the following example we will record some automation for the Subtractor device currently used together with the RPG-8, although the basic principle is the same for all devices.

1. **Make sure the Subtractor track is selected and has Master Keyboard input.**

2. **Locate the “Filter 1 Freq” parameter on the panel.**
   This parameter governs the filter frequency; i.e. how “open” or “closed” the filter is.

3. **Rewind to the start of the song and hit the Record button.**
   Recording starts after the one bar pre-count.

4. **Click on the Filter Freq slider and hold the mouse button down while slowly moving the mouse up and/or down.**

5. **Stop recording and click stop until you reach the start of the song.**
   As you can see, the Filter 1 Freq parameter now has a green border to indicate it is automated. Also, an automation lane for the Filter Freq parameter has been added on the Subtractor track in the sequencer. The automation events you recorded are contained in an automation clip on the automation lane.

6. **Start playback.**
   The filter parameter is now automated and will exactly mirror the slider movements you made during recording.

   - **Automation recording can be undone at any time just like other recorded events.**
   - **You can also draw automation curves in the sequencer.**
     This is described in the Sequencer chapters of the main Operation Manual.

That concludes the sixth and final tutorial! Please refer to the main Operation Manual for complete descriptions of Reason elements, procedures and devices.
Index
A
Adding devices 48
Arpeggiator 72
ASIO Driver 11, 19
Audio Card Driver 19
Audio Hardware 10
Audio Output 19
Automating parameters 74

B
Browsing for sounds 60

C
Computer Requirements 9
Control Surface (Adding) 22

D
Default Song 25
Devices
   About 32
   Creating 48
Direct Sound Driver 11, 19
Drum patterns 56

E
Effect Devices 52

F
Factory Sound Bank 13

K
Keyboard (Adding) 22

L
Latency 20
Load Default Sound for New Devices 50
Loops (REX) 68

M
Master Keyboard Input
   In Track List 50
   Mode 24
MIDI
   Adding a keyboard 22
   Connecting 12
   Keyboards and control surfaces 21
MME Driver 11, 19

O
Orkester Sound Bank 13

P
Parameter automation 74
Patches 51
Preferences dialog 18

R
Reason Factory Sound Bank see Factory Sound Bank
Reason Setup Wizard 16
Recording notes 62
Requirements 9
REX loops 68

S
Separated Mode 24
Sequencer
   Overview 30
   Recording 62
Song
   Playing back 44
   Selecting a Default Song 25
Sound Bank 13
Standard Mode 24

T
Tool window 31

W
Windows Multimedia Driver 11